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1 Overview

This manual covers installing and upgrading the TrueAllele® Casework server and
Visual User Interface (VUler™) software, and provides information about network
and backup systems. The basics of starting the program, connecting to a database,

and a glossary of common terms are also available in this manual.

The first two sections of this overview discuss the basics of the DNA interpretation
process and where additional educational material is found. This information is

useful for understanding how TrueAllele works.

The Visual User Interface (VUler) section gives information about the software
options available for use with TrueAllele. VUler allows the analyst to interact with

the TrueAllele server.

The System Requirements section gives the recommended system requirements for
optimal use of the TrueAllele VUler software. Minimum system requirements are

also supplied.
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1.1 DNA Interpretation Process

Bioloaical Lab SNA Interpret
iologica '
Evidegnce —> Signals —» | Genotype | — | Information

Figure 1. DNA Interpretation Process

The DNA interpretation process is broken down into two transformations (Figure 1).
The goal of each transformation is to preserve as much identification information as
possible. In the first step, a laboratory transforms the biological evidence samples
into DNA signals. The second transformation involves the interpretation of the DNA
signals into genotypes. The TrueAllele Casework software handles this step by
quantitatively interpreting DNA signals using probabilistic genotype modeling.

Mathematical formulas communicate the genotypes as identification information.

1.2 Background Information

There is a wealth of material available from Cybergenetics for learning about the
objective computer interpretation of quantitative DNA evidence. Essential
information is provided in this and other supporting manuals. Additional publications
and presentations are available on the Cybergenetics website at

www.cybgen.com/information.

Newsletters

The best place to begin is with Cybergenetics DNA Investigator™ newsletters,
located at https://www.cybgen.com/news/newsletters/page.shtml. These short
articles are written for the nonscientist. These newsletters introduce TrueAllele
Casework and show the system’s use in court, different validation studies, and

comparisons with human review.
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Publications
An introduction to a DNA likelihood ratio match statistic is found in this short

expository article, located at http://www.cybgen.com/go/ISHI2010.

The operation and significance of the TrueAllele system are described in this peer-
reviewed, scientific validation paper located at http://www.cybgen.com/go/JFS2011.

It is recommended to read this long article over three separate sessions:

1. Introduction, Materials and Methods. These sections teach the underlying prin-
ciples of probabilistic genotyping and DNA identification information. They also

explain how to rigorously assess the reliability of any DNA interpretation method.

2. Case Example. A DNA mixture from a real case was analyzed both by man and
machine. The computer's match score was a billion times greater. Ten different
reasons, explored at ten different genetic loci, are examined to explain how com-

puters can preserve the match information that humans discard.

3. Results and Discussion. Computer and human review that were conducted on
the same sixteen DNA mixture casework items are compared. The results show
TrueAllele computer’s reliability and show that the computer is typically a million
times more informative than human. The computer simply makes better use of
the DNA data.

Course Lectures

Course materials (videos, slides, transcripts, etc.) are provided about quantitative
DNA mixture interpretation, located at
http://www.cybgen.com/information/courses/page.shtml. The six 20 minute lectures
on "DNA Identification for Scientists: Basics & Methods" are the starting point for

students desiring a real understanding of scientific DNA interpretation.
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Additional References

After this basic introduction, there are scientific presentations about TrueAllele's
methods and results available for review, located at
http://www.cybgen.com/information/presentations/page.shtml. These short, narrated
PowerPoint movies provide a living history of the TrueAllele technology and its

applications as presented at scientific meetings.

Cybergenetics researchers have written many scientific publications about
TrueAllele evidence interpretation and how it fully preserves DNA identification

information, located at http://www.cybgen.com/information/publication/page.shtml.

1.3 Visual User Interface (VUIler)

An analyst installs the TrueAllele VUler software on their Macintosh or Windows
computer to interact with a TrueAllele server. This software allows the analyst to
upload data and requests and download the results that are stored on the TrueAllele
server. Depending on the needs of the analyst, there are three VUler versions

available: Full, Cloud, and Read-only.

Full

This VUler version is available to interact with the laboratory’s in-house TrueAllele
server. The analyst first analyzes their data in the Analyze module, uploads their
data in the Data module, asks interpretation questions in the Request module, and
reviews results in the Review and Report modules. A Tools module is available for
administrative purposes. Many different interfaces and features are present that
allow the analyst to view their data and separated genotypes in detail, ultimately for
reporting purposes. The accompanying user manuals describe the features of this

VUler version.
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Cloud

This VUler version is available to interact with the TrueAllele Cloud database
servers. It lets the analyst upload data for processing on the TrueAllele Cloud
server in the Upload module. After TrueAllele processing is complete, the analyst

downloads interpretation results in the Download module.

Read-only

This read-only version of the TrueAllele VUler software is available for reviewing
TrueAllele results. This version enables the Download module allowing an analyst
to download and review TrueAllele interpretation results. The Read-only version is

useful for administrative or court related purposes.

1.4 System Requirements

For best performance, the system requirements for the TrueAllele Visual User

Interface (VUler) software are:

For Macintosh computers:

0OS: Mac OS X 10.9.5 or higher
CPU: Intel Core 2 or later
RAM: 1 GB RAM

Storage: 1 GB of free hard drive space

Display: Screen resolution of 1920 x 1080 (Minimum resolution: 1024 x 768)
Graphics: Hardware accelerated graphics card supporting OpenGL 3.3 with 1GB

GPU memory recommended
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For Windows computers:

OS: Windows 7 or later

CPU: Intel Pentium 4 processor or later
RAM: 1 GB RAM

Storage: 1 GB of free hard drive space

Display: Screen resolution of 1920 x 1080 (Minimum resolution: 1024 x 768)
Graphics: Hardware accelerated graphics card supporting OpenGL 3.3 with 1GB

GPU memory recommended
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2 Software Installation (Macintosh)

This section walks through the TrueAllele VUler installation for a Macintosh
computer. A complete TrueAllele Casework installation package includes the MCR
Engine, the Analyze module of the VUler software, and the VUler software itself.
Cybergenetics supplies each part of the package for the complete installation of all

parts. Installation instructions for a Windows computer are found in Section 3.

2.1 MCR Engine

The MCR Engine is an underlying program that powers the graphics and statistical
calculations of the VUIler software. The MCR engine is never independently started

when operating VUler, but the program must be preinstalled for proper operation.

An analyst begins by expanding the zip file “MCR_Engine_Installer_v85.pkg.zip”,
which makes the package file “MCR_Engine_Installer_v85.pkg” available. The
analyst then control clicks on the package file and selects Open to begin the

installation process.

On the introduction screen (Figure 2), selecting ‘Continue’ advances to the next

screen.

TrueAllele VUlIer:
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« Install MCR_Engine_Installer

© Introduction

® Destination Sele
(&) mstallation[Type
® Installation

® Summaty

y

Welcome to the MCR_Engine_Installer Installer

You will be guided through the steps necessary to
install this software.

Yy errs—
Go Back (" Continue )

/|

Figure 2. Introduction Screen.

Next, the analyst selects a destination to install the software in the Destination

Select window (Figure 3). Most likely, this installation will be for all users of the

computer.
e 00 & Install MCR_Engine_Installer
Select a Destination

R A\ ‘ How do you want to install this software?

© Introduction A

filEestinationisel " Install for all users of this computer

® [nstal\at]or_}frype -

(] [nstal\am'a’n /

@ Summaty y

ol a - Installing this software requires 1.69 GB of space.
1
You have chosen to install this software for all users of this
computer.
| GoBack | | Continue
Figure 3. Destination Select Screen
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In the Installation Type window (Figure 4), the analyst selects ‘Install’ to begin the

installation process. When prompted, the administrator user name and password is
entered.

« Install MCR_Engine_lInstaller

Standard Install on “Macintosh HD"
© Introduction |
© Destination Sel\ This will take 1.69 GB of space on your computer.
© Installation Type Click Install to perform a standard installation of
S this software for all users of this computer. All

users of this computer will be able to use this
® Summaty software.

GCo Back Install

Figure 4. Standard Install.

Once installation is complete, selecting ‘Close’ exits the installer (Figure 5).

« Install MCR_Engine_Installer

The installation was completed successfully.

© Introduction

© Destination Select
O Installation Type

O Installation

© Summaty The installation was successful.

The software was installed.

Go Back Close
—_—

Figure 5. Installation complete.
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2.2 Analyze

The Analyze module transforms the raw sequencer files into quality checked peak
data for upload to the TrueAllele Server. Installing the Analyze module installs the
program itself and creates the user environment. If Analyze is already installed on a
Viewstation, the analyst should remove this application and corresponding
‘trueallele’ folder (found in Documents) before upgrading the program, saving any

customized files elsewhere, if necessary.

Program Installation
The analyst starts by expanding on the zip file “Analyze.pkg.zip”, which makes the
package file “Analyze.pkg” available. The analyst then control clicks on the package

file and selects Open to begin the installation process.

On the introduction screen (Figure 6), selecting ‘Continue’ advances to the next

screen.

« Install Databank Application

Welcome to the Databank Application Installer

to Cybergenetics TrueAllele® Analysis™ Installer

Introduction
This Installer will install Cybergenetics TrueAllele Analysis software. The
Analysis is used to process and review your STR DNA data using
Cybergenetics TrueAllele Technology.

Cybergenetics TrueAllele Analysis will let you check data quality, decide
which data to use, and prepare your casework STR DNA data for
TrueAllele interpretation.

This Installer guides you through the steps necessary to install the

bundled content for TrueAllele Analysis. To get started, please click
Continue.

Continue

Figure 6. Introduction Screen.
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The next screen contains a Read Me file for review (Figure 7). After reading the file,

the analyst selects ‘Continue’ to advance to the next screen.

« Install Databank Application

Important Information
TrueAllele Technology: Analysis Software
Introduction Cybergenetics
Read Me 2018

Intellectual Property

The TrueAllele Technology is protected by US patents 5,541,067,
5,580,728, 5,876,933, 6,054,268, 6,750,011, 6,807,490, 8,898,021,
and 9,708,642, and by European patent 1,229,135. International
patents are pending.

TrueAllele® is a registered trademark of Cybergenetics.

The VUler software, TrueAllele system, and the component software
and documentation are copyrighted materials of Cybergenetics.

1996-2018 Cybergenetics. All rights reserved.

Contact Information
Cybergenetics

Print... Save... Go Back Continue

Figure 7. Read Me.

Next is the license agreement (Figure 8). After selecting ‘Continue’, a prompt
appears to confirm agreement with the license. The analyst proceeds by selecting

‘Agree’.

« Install Databank Application
Software License Agreement

English
Introduction —

Reac End-User License Agreement for TrueAllele Technology

License

The "Agreement" refers to the Terms and Conditions described herein.

The "Contract Term" begins at the Effective Date of this Agreement.

The "Effective Date" is the date on which Payment is made.

The "Licensee" is the government agency operating under the laws of
their State, and having its principal office in the USA.

The "Licensor" is Cybergenetics, Corp., a corporation duly organized
and existing under the laws of the Commonwealth of Pennsylvania
and having its principal office at 160 North Craig Street, Suite 210,
Pittsburgh, Pennsylvania 15213, USA.

The "Location" is where the government laboratory is located.

The "Patent Rights" shall mean U.S. Patent Nos. 5,541,067,
5,580,728, 5,876,933, 6,054,268, 6,750,011 6,807,490, 8,898,021
and 9,708,642, European patent 1,229,135, and all United States
and foreign patents and/or patent applications claiming priority from
such patents, and shall apply solely to forensic casework of DNA
samples.

The "Pavment" is the mutuallv aareed unon amount paid bv the

Print... Save... Go Back Continue

Figure 8. License Agreement.
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If prompted, the analyst selects a destination to install the software in the
Destination Select window. Most likely this installation will be for all users of the

computer.

A standard install is automatically available. The analyst begins installation by
selecting ‘Install’ (Figure 9). When prompted, the administrator user name and

password is entered.

« Install Databank Application
Standard Install on “Macintosh HD”

e uction This will take 85.5 MB of space on your computer.

Read Me Click Install to perform a standard installation of this software
s for all users of this computer. All users of this computer will be
License able to use this software.

Destination Select

Installation Type

Go Back Install

Figure 9. Standard Install.

After the installation is complete, selecting ‘Close’ finishes the process (Figure 10).
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« Install Databank Application

The installation was completed successfully.

Congratulations!
Introduction

Read Me

You can now use Cybergenetics latest TrueAllele® Analysis software.

License
Destination Select
Installation Type
Installation

Summary

Figure 10. Installation complete.

This completes the installation of the Analyze module. The analyst’s data can now

be processed.

User Environment

The user environment includes all necessary templates and settings for processing
the data in Analyze and is contained in a ‘trueallele’ folder. After installation, the
‘trueallele’ folder appears in the Documents folder of the user account. For
example, if a user is logged in as ‘DNA’, the ‘trueallele’ folder will be created in

DNA’s documents folder.

TrueAllele VUlIer:
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2.3 VUler

The VUler software allows the analyst to upload and ask questions of the case data

and then review the answers produced by the TrueAllele computer. If VUler is

already installed on a Viewstation, the analyst should remove this application and

save any customized preference files (such as the connect.txt or report.txt files)

elsewhere on the computer before updating VUler, if necessary.

The analyst starts by expanding the zip file “VUler.pkg.zip”, which makes the

package file “VUler.pkg” available. The analyst then control clicks on the package

file and selects open to begin installation.

On the introduction screen (Figure 11), selecting ‘Continue’ advances to the next

screen.

Introduction

« Install VUler

Welcome to the VUIer Installer
Welcome to Cybergenetics TrueAllele® VUler™ Installer

This Installer will install Cybergenetics TrueAllele Visual User Interface
(VUler) software. The VUler is used to process and review your STR
DNA data using Cybergenetics TrueAllele Technology.

Cybergenetics TrueAllele VUler will let you check data quality, decide
which data to use, set up cases for TrueAllele interpretation, initiate
TrueAllele calculation of genetic profiles and their matches, and visually
review genetic data and TrueAllele results.

This Installer guides you through the steps necessary to install the

bundled content for TrueAllele VUler. To get started, please click
Continue.

Continue

Figure 11. Introduction Screen.

The next screen contains a Read Me file for review (Figure 12). After reading the

file, the analyst selects ‘Continue’ to advance to the next screen.
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Introduction
Read Me

« Install VUler

Important Information
TrueAllele Technology: VUler™ Software

Visual User Interface (VUler) for TrueAllele Review
Cybergenetics
2019

Client / Server Architecture
TrueAllele Scientific Calculator (TASC™) Server

Cybergenetics TrueAllele Scientific Computer (TASC™) is a multi-
processor supercomputer instrument for inferring and matching DNA
profiles. The TASC instrument holds STR data on a central
coordinating database. When asked specific forensic questions about
a case, the multiple computers on the TASC system automatically
interpret these data and infer genetic profiles. The TASC DNA matcher
then compares these profiles for human identity. The computed
TrueAllele profiles and matches are recorded on the database.

ATASC instrument can process hundreds of evidence samples (single
source and mixtures) in a working day. TrueAllele schedules the
"autoloading" of the interpretation requests in priority order, so that

Ancnn aantinuanichs nrannace tinatandad  Tha TriuaAllala Aatnhaca

Print... Save... Go Back Continue

Figure 12. Read Me.

Next is the license agreement (Figure 13). After selecting ‘Continue’, a prompt

appears to confirm agreement with the license. The analyst proceeds by selecting

‘Agree’.

Introduction
Read Me

License

« Install VUler
Software License Agreement

English [T]

End-User License Agreement for TrueAllele Technology

The "Agreement" refers to the Terms and Conditions described herein.
The "Contract Term" begins at the Effective Date of this Agreement.
The "Effective Date" is the date on which Payment is made.

The "Licensee" is the government agency operating under the laws of
their State, and having its principal office in the USA.

The "Licensor" is Cybergenetics, Corp., a corporation duly organized
and existing under the laws of the Commonwealth of Pennsylvania
and having its principal office at 160 North Craig Street, Suite 210,
Pittsburgh, Pennsylvania 15213, USA.

The "Location" is where the government laboratory is located.

The "Patent Rights" shall mean U.S. Patent Nos. 5,541,067,
5,580,728, 5,876,933, 6,054,268, 6,750,011 6,807,490, 8,898,021
and 9,708,642, European patent 1,229,135, and all United States
and foreign patents and/or patent applications claiming priority from
such patents, and shall apply solely to forensic casework of DNA
samples.

The "Pavment" is the mutuallv aareed unon amount paid bv the

Print... Save... Go Back Continue

Figure 13. License Agreement.
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If prompted, the analyst selects a destination to install the software in the
Destination Select window (Figure 14). Most likely this installation will be for all

users of the computer.

[ ] @ Install VUler

Select a Destination

Introduction How do you want to install this software?
Read Me

- (7] Install for all users of this computer
Destination Select =

Installing this software requires 5.4 MB of space.

You have chosen to install this software for all users of this
computer.

Go Back

Figure 14. Destination Select Screen

A standard install is automatically available (Figure 15). The analyst begins the
installation by selecting ‘Install’. When prompted, the administrator user name and

password is entered.

TrueAllele VUlIer:
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« Install VUler

Standard Install on “Macintosh HD"

Introduction

License able to use this software.
Destination Select

Installation Type

Customize

This will take 5.4 MB of space on your computer.

Read Me Click Install to perform a standard installation of this software
for all users of this computer. All users of this computer will be

Go Back Install

Figure 15. Standard Install.

A custom installation can be performed anytime that the VUler software is installed

on a computer. In the Installation Type window, selecting ‘Customize’ brings up the

Custom Install options (Figure 16). The analyst is able to deselect any of the items

that they do note wish to install when installing/upgrading VUler. This action will

affect the installation of some required user files.

« Install VUler

Custom Install on “Macintosh HD”

Package Name
Introduction 7 TrueAllele
Read Me 2 VUler
License

Destination Select

Installation Type

Space Required: 5.4 MB

Standard Install

Action Size
Upgrade 123 KB
Upgrade 5.2 MB

Remaining: 448.28 GB

Go Back Install

Figure 16. Custom Install.
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After the installation is complete, selecting ‘Close’ finishes the process (Figure 17).

The VUler software is now installed and available for use.

« Install VUler

The installation was completed successfully.

Congratulations!

Introduction )
You can now use Cybergenetics latest TrueAllele® VUler™ software as

Read Me your Visual User Interface into TrueAllele scientific calculations. To get
i started, just log into any TASC™ database to see your genetic data and
License identification results.

Destination Select
Installation Type
Installation

Summary

Figure 17. Installation complete.
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3 Installation (Windows)

The steps for installing the MCR Engine, Analyze, and VUler software on a 64-bit
Windows computer are found in this section. As with a Macintosh, the MCR engine
must be installed first to allow the VUler software to be used. Also, the analyst
should note that before updating any of the programs, the customized user
directories and preferences could be saved elsewhere on the computer in order to

preserve and reinstate them after an update.

3.1 MCR Engine

An analyst begins by expanding the zip file “MCR_Engine_Installer_v85.exe.zip”,
which makes the executable file “MCR_Engine_Installer_v85.exe” available. The

analyst then double clicks on the executable file to begin the installation process.

On the introduction screen (Figure 18), selecting ‘Next’ advances to the next screen.

TrueAllele VUlIer:
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4\ MATLAB Runtime Installer ! o | Gl

This application will install MATLAB Runtime.

MATLAB

R2015a

MATLAB and Simulink are registered trademarks of The MathWorks, Inc. Please see
mathworks.com/trademarks for a list of additional trademarks. Other product or brand names
may be trademarks or registered trademarks of their respective holders.

WARNING: This program is protected by copyright law and international treaties. Copyright
1984-2015, The MathWorks, Inc. Protected by U.S. and other patents.See MathWorks.com/patents

J MathWorks

Figure 18. Introduction Screen.

The next screen contains a license agreement for review (Figure 19). After reading
and accepting the agreement, the analyst selects ‘Next’ to advance to the next

screen.

4\ License Agreement -

The MathWorks, Inc.

MATLAB RUNTIME LICENSE

m

IMPORTANT NOTICE
BY CLICKING THE "YES" BUTTON BELOW, YOU ACCEPT THE TERMS OF THIS LICENSE. IF YOU ARE NOT WILLING TO DO
SO, SELECT THE "NO" BUTTON AND THE INSTALLATION WILL BE ABORTED.

1. LICENSE GRANT. Subject to the restrictions below, The MathWorks, Inc. ("MathWorks") hereby grants to you, whether
you are an individual or an entity, a license to install and use the MATLAB Runtime ("Runtime"), solely and expressly for
the purpose of running software created with the MATLAB Compiler (the "Application Software"), and for no other
purpose. This license is personal, nonexclusive, and nontransferable.

2. LICENSE RESTRICTIONS. You shall not modify or adapt the Runtime for any reason. You shall not disassemble,
decompile, or reverse engineer the Runtime. You shall not alter or remove any proprietary or other legal notices on orin
copies of the Runtime. Unless used to run Application Software, you shall not rent, lease, or loan the Runtime, time share
the Runtime, provide service bureau use, or use the Runtime for supporting any other party's use of the Runtime. You

L e m c L F—! i f

Do you accept the terms of the license agreement?

et ) MatWorks

Figure 19. License Agreement.
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Next, the analyst clicks ‘Next’ in the Folder Selection screen to install the software in

the default destination folder (Figure 20).

Choose installation folder:

MATLAB
Restore Default Folder ] R2015a

N ) MathWorks

Figure 20. Folder Selection Screen.

If prompted, the analyst confirms the creation of the destination folder by selecting
‘Yes’ (Figure 21).

4\ Folder Selection &‘

The destination folder C:\Program Files\MATLAB\MATLAB Runtime\ does not exist.
Would you like to create it? l

Figure 21. Folder Selection Confirmation.

In the Confirmation window (Figure 22), the analyst selects ‘Install’ to begin the
installation process. If prompted, the administrator user name and password is

entered.
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Installation folder:
C:\Program Files\MATLAB\MATLAB Runtime\v85

Installation Size: 1,546 MB

Products:
MATLAB Runtime 8.5

J MathWorks'

Figure 22. Confirmation Window.

Once installation is complete, selecting ‘Finish’ exits the installer (Figure 23).

4\ Installation Complete -

Installation is complete.

MATLAB

R2015a

) MathWorks

Figure 23. Installation Complete Screen.
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3.2 Analyze

To install the Analyze module on a Windows computer, the analyst starts by
expanding the zip file “Analyze_64bit.exe.zip”, which makes the executable file
“‘Analyze 64bit.exe” available. The analyst then double clicks on the execute file to

begin the installation process.

On the introduction screen (Figure 24), selecting ‘Next advances to the next screen.

-
8] TrueAllele - InstallShield Wizard (S

Welcome to the InstallShield Wizard for TrueAllele

The InstallShield(R) Wizard will install TrueAllele on your computer. To continue, dick Next.

WARNING: This program is protected by copyright law and
international treaties.

Cybergenetics

Back [ Next > ] [ Cancel

Figure 24. Introduction Screen.

The next screen contains a license agreement for review (Figure 25). After reading
and accepting the agreement, the analyst selects ‘Next’ to advance to the next

screen.
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8 TrueAllele - InstallShield Wizard (o]

License Agreement .‘\
Please read the following license agreement carefully.

End-User License Agreement for TrueAllele Technology (4

The "Agreement” refers to the Terms and Conditions described
herein.

The "Contract Term" begins at the Effective Date of this
Agreement.

The "Effective Date" is the date on which Payment is made.

The "Licensee" is the government agency operating under the -

© 1 accept the terms in the license agreementt

(7)1 do not accept the terms in the license agreement

InstallShield

[ < Back ][ Next > ] [ Cancel ]

Figure 25. License Agreement.

Next is the customer information screen (Figure 26). After entering the appropriate
information and selecting the user(s) to install the application for, the analyst selects

‘Next’ to proceed.

8 TrueAllele - InstallShield Wizard S5

Customer Information \
Please enter your information.

User Name:
fpna

Organization:
ICybergeneﬁcs

Install this application for:

@ Anyone who uses this computer (all users)
() Only for me (DNA)

InstallShield

[ < Back ][ Next > ] [ Cancel

Figure 26. Customer Information Screen.
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On the next screen, the analyst chooses the default setup type and clicks ‘Next’ to
continue (Figure 27).

8 TrueAllele - InstallShield Wizard [
Setup Type \
Choose the setup type that best suits your needs.
Please select a setup type.

All program features will be installed. (Requires the most disk
space.)

() Custom

Choose which program features you want installed and where they
will be installed. Recommended for advanced users.

InstallShield

[ < Back ][ Next > ] [ Cancel

Figure 27. Setup Type Window.

On the ready to install screen (Figure 28), the analyst selects Install to begin the

Analyze installation. If prompted, the administrator user name and password is
entered.

%) TrueAllele - InstallShield Wizard (23]

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dlick Back. Click Cancel to
exit the wizard.

InstallShield

[ < Back ][ Install ] [ Cancel

Figure 28. Ready to Install.
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After the installation is complete, selecting ‘Finish’ completes the process (Figure
29). This completes the installation of the Analyze module, and data can now be

processed in the Analyze module.

-
18 TrueAllele - InstallShield Wizard S5

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed TrueAllele.
Click Finish to exit the wizard.

Figure 29. Installation Complete.

If necessary, the analyst should copy the ‘trueallele’ folder to every user’'s ‘My
Documents’ directory and add or replace any custom user directories or templates to

this ‘trueallele’ folder.

Updating Analyze

Before updating Analyze, the analyst should first copy any customized files to be
kept from the C:/Users/username/My Documents/trueallele/system folder. Then, the
analyst should uninstall any older versions of Analyze by using the Add or Remove
Programs feature. After removing the software, the analyst should delete the

C:/ Users/username/My Documents/trueallele directory for every user. Then,

Analysis can be updated following the same steps outlined previously.
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3.3 VUler Software

To install the VUler software, the analyst starts by expanding the zip file
“VUler_64bit.exe.zip”, which makes the package file “VUler_64bit.exe” available.

The analyst then double clicks on the executable file to begin installation.

On the introduction screen (Figure 30), selecting ‘Next’ advances to the next screen.

-
) VUler - InstaliShield Wizard [

Welcome to the InstallShield Wizard for VUIer

The InstallShield(R) Wizard will install VUIer on your computer. To continue, dlick Next.

TrueAllele Technology is protected by US patents 5,541,067,

C]' H 5,580,728, 5,876,933, 6,054,268, 6,750,011, 6,807,490,
bergenet’cs 8,898,021, and 9,708,642, and by European patent
1,229,135, Copyright 1997-2013 Cybergenetics.

Back [ > Next ] [ Cancel

Figure 30. Introduction Screen.

The next screen contains a license agreement for review (Figure 31). After reading
and accepting the agreement, the analyst selects ‘Next’ to advance to the following

screen.
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) VUler - InstaliShield Wizard 5

License Agreement ",
Please read the following license agreement carefully.

End-User License Agreement for TrueAllele Technology 4

The "Agreement" refers to the Terms and Conditions described
herein.

The "Contract Term" begins at the Effective Date of this
Agreement. [

The "Effective Date" is the date on which Payment is made.

The "Licensee" is the government agency operating under the -

©1 accept the terms in the license agreement!

() I do not accept the terms in the license agreement

InstallShield

[ < Back ][ > Next ] [ Cancel ]

Figure 31. License Agreement.

Figure 32 shows the customer information screen. After entering the appropriate
information and selecting the user(s) to install the application for, the analyst selects

‘Next’ to proceed.

) VUler - InstaliShield Wizard =

Customer Information \
Please enter your information.

User Name:
[ona

Organization:
lebergeneﬁcsl

Install this application for:

@ Anyone who uses this computer (all users)
() Only for me (DNA)

InstallShield

[ <Bak | >Next |[ cancel

Figure 32. Customer Information Screen.
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On the next screen, the analyst chooses the default setup type and clicks ‘Next’ to

continue (Figure 33).

) VUler - InstaliShield Wizard =

Setup Type
Choose the setup type that best suits your needs.

Please select a setup type.

@ Complete

All program features will be installed. (Requires the most disk
space.)

() Custom
[ Choose which program features you want installed and where they
will be installed. Recommended for advanced users.

InstallShield

[ <Bak [ >Next ][ cancel

Figure 33. Setup Type Window.

On the ready to install screen (Figure 34), the analyst selects Install to begin the

VUler installation. If prompted, the administrator user name and password is

entered.
) VUler - InstaliShield Wizard -
Ready to Install the Program \
The wizard is ready to begin installation.
Click Install to begin the installation.
If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.
InstallShield
[ <Back [ sl ][ cancel |
v
Figure 34. Ready to Install.
TrueAllele VUIer: .
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After the installation is complete, selecting ‘Finish’ completes the process (Figure

35). The VUler software is now installed and available for use.

ﬁ VUIer - InstallShield Wizard

==

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed VUIer. Click

Finish to exit the wizard.

Figure 35. Installation Complete.
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4 Software Function

This section covers the starting the VUler program including information about the
license key and Module Chooser. The Appendix » Diagnostic Support covers an
alternative method for starting the program. In addition, this section discusses

connecting to a database and closing the VUler program.

4.1 License

After installing VUler, the analyst starts the program by clicking on its icon (Figure
36). The application is located in the Dock or Applications folder on a Macintosh or

from the Desktop shortcut or Start Menu on a Windows computer.

Figure 36. VUler icon.

A valid license key is required to use the VUler software. Cybergenetics provides
this license key. When starting VUIler for the first time, a dialog box appears
prompting the analyst to enter a license key (Figure 37). This key is only entered
the first time the software is started. VUler will open to the Module Chooser after a

valid license key is entered.
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O O O License Key

Please enter icense key

OK Cancel

Figure 37. License key input dialog box.

4.2 Module Chooser

The Module Chooser opens after a valid license key is entered. This interface is
where the analyst uploads data and downloads results. The interface is different for

each of the VUler versions.

In the Full VUIler version, all modules are available for use (Figure 38).

[ J Choose Module
App

Cybergenetics

TrueAllele® Technology

SR W
r‘%&“g | f Q

Analyze Data Request

Q |

aooo
aooo
ooo s

7 ==

Review Report Tools

Figure 38. Full Module Chooser.
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In the VUler Cloud version, both the Upload and Download modules are available
(Figure 39).

8 00 Choose Module
App

Cybergenetics

TrueAllele® Technology

Upload Download

Figure 39. Cloud Module Chooser.

For the VUler Read-only version, only the Download module is available for

reviewing results (Figure 40).

8 00 Choose Module

Cybergenetics

TrueAllele® Technology

Download

Figure 40. Read-only Module Chooser.
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4.3 Connecting to a Database

In the VUler program, the Connect window allows an analyst to connect to a
database or to switch to a different database at any time during the TrueAllele
process. The analyst opens the Connect window by selecting the Database »

Connect menu option in any VUler module.

Connect window

To connect, an analyst selects the desired server System from the dropdown menu
(this action fills in the System field as well). The analyst then enters a username
and password under the Authenticate heading and clicks ‘Verify’. A blue check mark
is present when the connection is verified, and the Connect window (Figure 41) will

automatically close.

Connect
Database

Select Database [T]
System system.information

Database project

Authenticate

Username user

Password

Verify
Status
9 Database connection required
Close Clear

Figure 41. The Connect window.

Clearing Information
To clear all of the information entered in the Connect window fields and exit the
database, the analyst can use the ‘Clear’ button at the bottom right of the window.

When finished with this process, the ‘Close’ button will close the window.
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Connection Difficulties
If a red “X” appears with the message “Database Connection Failure” when clicking
the ‘Verify” button instead of the blue check or the window closing, the connection to

the database was not successful.

This message could mean that incorrect user account information was entered. The
user name and password are case sensitive, so the analyst should first check that

the information was entered correctly.

4.4 Closing the VUler Program

The TrueAllele Server accepts a limited number of concurrent user connections. An
analyst must properly end user sessions so the connection is open for another

analyst. There are two main methods of ending a user session.

When finished using the VUler software, the analyst can close the program by
selecting App » Quit. This will close the program and automatically log out of any

current connections.

If an analyst does not want to close the VUler program but wishes to end the current
session, the analyst can logout of a TrueAllele World. From within any module,
selecting Database » Logout will log an analyst out of the current database, making

the connection available for other users.

To close a window within a module, the analyst selects File » Close. To close a
module and go back to the Module Chooser, an analyst selects File » Exit Module.
This selection brings up a dialog box asking an analyst if they wish to exit the
particular module and choose a different one. Here an analyst selects “Yes” to exit

or “Cancel” to remain in the current module.
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5 Network Setup

This section discusses the details regarding network setup for TrueAllele server

management.

5.1 Adding Server to Client Network

Before using TrueAllele, the server must be set up. The following section addresses
the steps to set up the server and network. If additional help is needed,

Cybergenetics should be contacted for support.
To add the server to the network:

Unpack server then locate network and power.

e Plug Ethernet cord in Ethernet port #1.

Log in with root password.

e Type ‘startx’to bring up the graphical user interface.

The Star icon & is the Network dialog and is found in the top menu bar or under

the System P Administration » Network menu.
e Select eth0 by double clicking it from the dialog that opens (Figure 42).

e Type IP address, subnet mask and gateway (if necessary) into Ethernet Device
dialog that opens. Click OK after all information is entered.
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—_———————
Ethernet Device

General | Route \ Hardware Device

Nickname: ‘ eth0

Activate device when computer starts
["] Allow all users to enable and disable the device

[[] Enable IPv6 configuration for this interface

) Automatically obtain IP address settings with:

V|

(@) Statically set IP addresses:

Manual IP Address Settings

Address: [192.168.0.21 |

Subnet mask: |255.255.255.0 |

Default gateway address: [192.168.0.1] J

[] Set MTU to:
[ Set MRU to: |0 =

|xg_ancelH & ok ]

Figure 42. The Ethernet Device dialog.

Next, the Network Configuration window opens. Select ethO from the list and click
the Deactivate button to refresh network (Figure 43). If prompted, save changes.

Click the Activate button to bring the network back up with the new settings applied.

Network Configuration

File Profile Help

B « D v ®

New  Edit Copy Activate  Deactivate

Devices ‘ Hardware ‘IP;ec ‘DNS I Hosts I

_, %0 Youmay configure network devices associated with
j[g physical hardware here. Multiple logical devices can be

'y associated with a single piece of hardware.
iProfiIe Status Device Nickname Type ‘
' Active ethl: ethl:2 Ethernet
Y Active - eth0 eth0 Ethernet
& Active @ ethl ethl Ethernet
& Active @ ethl: ethl:0 Ethernet
& Active (@ ethl: ethl:1 Ethernet

Active profile: Common (modified)

Figure 43. The Network Configuration window.
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If you need to restart the network manually you can do so from the Terminal. To

restart the Network: In Terminal, type “service network restart”andthen

press Enter.

In Terminal, type “ip addr” to check that the ip address is correct (under ethO

entry, inet line) (Figure 44).

root@coordinatel:~

File Edit View Terminal Tabs Help

[root@coordinatel ~]# ip addr =
1: lo: <LOOPBACK,UP,LOWER UP> mtu 16436 qdisc noqueue
link/loopback 00:00:00:00:00:00 brd 00:00:00:00:00:00
inet 127.0.0.1/8 scope host lo
inet6 ::1/128 scope host
valid 1ft forever preferred 1ft forever
2: eth®: <BROADCAST,MULTICAST,UP,LOWER UP> mtu 1500 qdisc pfifo_fast qlen 1000
link/ether 00:23:7d:36:71:fc brd ff:ff:ff:ff:ff:ff
inet 192.168.1.200/24 brd 192.168.1.255 scope global eth@®
inet6 fe80::223:7dff:fe36:71fc/64 scope link
valid 1ft forever preferred 1ft forever
3: ethl: <NO-CARRIER,BROADCAST,MULTICAST,UP> mtu 1500 gqdisc pfifo_fast glen 1000
link/ether 00:18:71:ec:78:e7 brd ff:ff:ff:ff:ff:ff
inet 10.0.1.1/8 brd 10.255.255.255 scope global ethl
inet 10.0.2.1/8 brd 10.255.255.255 scope global secondary ethl:0®
inet 10.0.3.1/8 brd 10.255.255.255 scope global secondary ethl:1
inet 10.0.4.1/8 brd 10.255.255.255 scope global secondary ethl:2
4: sitO@: <NOARP> mtu 1480 qdisc noop
link/sit 0.0.0.0 brd 0.0.0.0
[root@coordinatel ~]# [i

Figure 44. The results of ip addr.

You can confirm the server has been correctly setup from the TrueAllele

ViewStation.

5.2 Confirm the Network Connection

The following section outlines the steps for confirming the network connection to the

server.

To confirm the network connection:

Open VUler and select the Request module.
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In the menu bar, select Database P Connect.
Select ‘general use’ from the drop-down menu.

In the URL enter the server IP address.

Enter general TrueAllele World account information.
Press the Verify button.

Blue check means that the network is up and running.

If there is a red X, the VUler is unable to reach the server.

5.3 Update the Connect File

After the server is running, the connect file can be edited in order to have the

software auto-complete the connection information.

To update the connect file:

Connect File:

Open the Tools module.

From the Tools menu select ‘VUler Preferences’.

From the drop-down menu in the dialog select ‘Connect’.

Edit the connect file by replacing (insert server IP) with the server’s IP address.

Save the file as text.
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6 Backup Setup

The TrueAllele Server performs automated daily backups of each of the TrueAllele
Worlds on the server. These backup files contain a complete copy of all requests

and data that are present on that World.

The backup files are stored on the server in the /backup/download directory. This
folder is accessible via the root account and can be copied to other media to provide

off-machine backup.

6.1 Copying to Physical Media

The following section outlines the steps to backup the server onto physical media.

Physical media includes CDs, external hard drives, etc.

Note: This assumes that the system has not yet been logged in and the process is

starting from the log in window.
To save backups to physical media:

At the login prompt, log in as the root user. Once you are logged in as root, type
‘startx’ to start the GUI.

To navigate to the /backup directory, select the Computer icon on the desktop. This
will open a Linux file explorer window. Select Filesystem to open a window showing
the top-level / directory. Select backup to enter the backup directory and see the

/download directory. The /download directory contains all of the backup files.
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When you insert optical media (DVD or CD), a new icon will appear on the desktop
called Blank DVD+R Disc. (The exact name will vary based on the media used).
Simply click and drag the /download directory to the media. Select the media icon to
open a CD/DVD Creator. All files that will be burned to the media will be displayed
in this window. Select the ‘Write to Disc’ button in the top right to begin the writing

process.

For external hard drives or thumb drives, simply plug the drive into the server. A
new icon for the hard drive will appear on the desktop. You can simply drag the

/download directory to that icon to move files to the hard drive.

6.2 Copying Files via the Network

To aid the transfer of files between the server and another computer, an FTP client
can be used. Cybergenetics recommends using WinSCP for Windows or
Cyberduck for Macintosh. These programs provide a visual interface for moving
files over a network via SFTP. The steps to perform this task are outlined in the

following section.

Note: The following instructions are for using Cyberduck on a Mac ViewStation. The

steps for using WinSCP on a PC are similar.
To transfer files between the server and another computer:

Start Cyberduck, and select the Open Connection button in the menu bar (Figure

45). This will open a New Connection dialog.
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&
—y
Open Connection

Figure 45. The Open Connection icon.
Fill out the New Connection dialog with the following parameters (Figure 46):

Username: root

Password: root password (this information is specific to the server)
Server: server IP address (this information is specific to the server)
File protocol: SFTP

Port number: 22

() SFTP (SSH File Transfer Protocol)

<>

Server: (insert server IP) v Port: 22

URL: sftp://root@(insert server 1P):22/ !

Username: root
Password:

"] Anonymous Login
Z Add to Keychain

(?) ( Cancel ) ( Connect

More Options

Figure 46. The New Connection dialog.

After establishing a secure FTP connection, you will be presented with a file explorer

interface. This interface will let you drag files and folders to the remote computer.

Select the directory drop-down from the menu bar and select the top-level directory
/. The main finder window (Figure 47) will now display all the directories under the
top-level including /backup. Select /backup, and you will see the /download directo-
ry. Simply drag and drop the /download directory onto the Mac Desktop to begin

copying the complete backup information.
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system11.trueallele.net -\ Get a donation key!
| ] ]

g,a (=] &)
Open Connection Quick Connect Action Refresh
(@) <« » |(GE/ (sl

Filename A Size Modified
(] backup 4.0KB 10/16/08 4:49 PM
(] bin 4.0 KB 10/16/08 6:17 PM
|| boot 4.0KB 10/16/08 3:43 PM
|| dev 3.7KB 4/18/11 8:24 PM
ll etc 12.0KB 5/6/11 4:04 AM
|| home 4.0KB 10/16/08 4:49 PM
L]lib 4.0KB 10/16/08 6:17 PM
|| lib64 4.0KB 10/16/08 6:16 PM
|| lost+found 16.0KB 10/16/08 3:07 PM
|| media 4.0KB 4/18/11 8:24 PM
L] misc 4.0KB 11/12/07 1:16 AM
| mnt 4.0 KB 3/29/07 1:00 PM
(2] net 4.0 KB 10/16/08 4:42 PM
|| opt 4.0 KB 3/29/07 1:00 PM
|| proc 0B 4/18/11 8:23 PM
| root 4.0KB 12/7/09 10:40 AM
] sbin 12.0KB 10/16/08 6:17 PM
|| selinux 4.0KB 10/16/08 3:36 PM
L] srv 4.0 KB 3/29/07 1:00 PM
|| sys 0B 4/18/11 8:23 PM
] tmp 4.0 KB Today 5:21 AM
|| usr 4.0KB 1/30/06 6:10 PM
| var 4.0KB 1/30/06 6:17 PM
23 Files 4
Figure 47. The main Finder window displaying /.

Once the files have finished moving, you can store the backup on other media. The
iMac ViewStation supports burning to a DVD or moving the files to an external hard

drive.
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Appendix

This appendix is designed to provide specific information that may help in using the

TrueAllele VUIler software. A glossary of common terms is also provided.

Spinning Wait Cursor

| 3
[
Spinning Wait Cursor

The spinning wait cursor is equivalent to the hourglass icon on a Windows
computer. This icon indicates that TrueAllele is retrieving data from the database.
This cursor is only active when it is held over a VUIler window. If the mouse is
moved off of the window (for example, to the desktop), the cursor will go back to the

normal pointer.

View Menu

In several modules of the VUler program, there is a View Menu. This menu allows
the analyst to change the window sizing options for modules that have more than
one interface window open at a time. The View Menu includes options for
automatically sizing and positioning the interfaces as well as making the interface
text larger and smaller. There are also toolbar buttons that allow the analyst to
position the interface windows on the screen (Figure 48), where the white portion of

the icon indicates where the window will be positioned. In addition, keyboard
shortcuts exist for making interface text larger (88=) and smaller (38-) (ctrl= and ctrl—

for Windows).
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Figure 48. View Icons. These icons position the active interface window to the position on the screen
denoted by the white part of the square.

Diagnostic Support

To aid in diagnostic support of the VUler program, an alternate means of starting the
program is available. This method is not routinely used but is available to aid in

support calls to Cybergenetics.

Macintosh support
On a Macintosh, the analyst opens a Terminal window by selecting the Terminal

icon (Figure 49) from the Dock or Applications/Utilities folder.

Figure 49. Terminal icon.

A blank Terminal window opens (Figure 50), displaying the computer’'s name and a

command prompt.
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® 00 /N dna — bash — 80x24 3

Last login: Fri Mar 27 10:26:45 on ttys001 L
Pinguino:~ dna$

Figure 50. A blank Terminal window.

In the Terminal window, the analyst copies and pastes the path:
/Applications/VUIer.app/Contents/Mac0S/prelaunch
And then hits the enter key (Figure 51).

8 O O /N dna — bash — 80x24 "

Last login: Fri Mar 27 10:26:45 on ttys001 L
Pinguino:~ dna$ /Applications/VUIer.app/Contents/MacOS/prelaunch

Figure 51. A Terminal window with the path filled in.
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Windows support
On a Windows computer, the analyst opens a Command Prompt window by

selecting the program from the computer.

A blank Command Prompt window opens (Figure 52), displaying the computer

user’s name and a command prompt.

B C:\Windows\system32\cmd.exe oo =]

Microsoft Windows [VUersion 6.1.76011]
Copyright {(c)> 2809 Microsoft Corporation. All rights reserved.

m|»

C:\Users\cyhergenetics>

Figure 52. A blank Command Prompt window.

In the Terminal window, the analyst copies and pastes the path:

C:\Program Files\VUIer\VUIer.exe

And then hits the enter key (Figure 53).
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@8 C:\Windows\system32\cmd.exe o[-

Microsoft Windows [VUersion 6.1.76011]
Copyright (c> 2809 Microsoft Corporation. All rights reserved.

m/»

C:\Users\cybergenetics>"C:\Program Files\UUIer\UUler.exe"

Figure 53. A Command Prompt window with the path filled in.

By starting the VUler program this way, diagnostic messages that are displayed
during software operation appear in the Terminal window. These messages can be

copied and pasted into an email to Cybergenetics if support is required.

Glossary

This glossary presents some commonly used terms. The term of interest is

italicized.
Evidence data comprise STR experiments on a set of samples.

An observed genotype is a probability distribution over a set of possible allele pairs

at a locus.

The identification hypothesis is that a suspect contributed their DNA to an evidence

sample.

Identification information is the logarithm of the identification LR.
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A likelihood function determines the fit between data and model. (More formally, it is

the probability of the data given a model.)
An identification likelihood ratio (LR) is the weight of evidence in favor of an
identification hypothesis. The LR can be calculated as a ratio of two match

probabilities.

A Markov chain is a visual history of the search that the system performs in order to
find the best-fit model for the data.

A match occurs when two genotypes are equal.

A match probability is the probability of a genotype match.

A mixture is a DNA sample that contains two or more individual contributors.

A probability model is a mathematical formulation that accounts for observed data.

A validation study assesses the efficacy and reproducibility of an interpretation

method for extracting identification information from DNA data.
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